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ABSTRACT 

Padang Pariaman Regency has several large rivers, one of which is the Batang Tapakis’s river. Research 
on Batang Tapakis is very rarely researched. The following is documentation of Batang Tapakis, precisely 
at the Tiram Bridge, Jalan Syekh Burhanuddin, Nagari Tapakis, Ulakan Tapakis District, Padang Pariaman 
Regency, West Sumatra. On Wednesday, 24 January 2023, a flood occurred in Korong Kasai Nagari 
Tapakis which caused 1,200 families to flee. The flood height is estimated to be 80 cm. Therefore, in this 
study, research uses HEC-RAS and GIS applications to display the distribution of floods and flood water 
levels.This research was conducted using primary, secondary data and DEM data downloaded from 
DEMNAS. The use of the GIS application, namely Global Mapper, functions to convert DEM data in 
GeoTiff format into prj so that it can be processed into HEC-RAS. In the HEC-RAS application there is a 
RAS Mapper tool which functions to describe the results of flood distribution and flood height. From the 
results of utilizing DEM data using HEC-RAS and GIS in Batang Tapakis, it can show a picture of 
inundation in Korong Tapakis and the flood height is between 70-80 cm which corresponds to the flood 
that occurred on 24 January 2023 as high as 80 cm.  
Key words: flood, river, DEM, GIS, HEC-RAS 
 

INTISARI 

Kabupaten Padang Pariaman memiliki beberapa sungai besar salah satunya sungai Batang Tapakis. 
Penelitian mengenai Batang Tapakis sangat jarang diteliti. Berikut dokumentasi Batang Tapakis tepatnya 
di Jembatan Tiram, Jalan Syekh Burhanuddin, Nagari Tapakis, Kecamatan Ulakan Tapakis, Kabupaten 
Padang Pariaman, Sumatera Barat. Pada saat Rabu, 24 Januari 2023 terjadi banjir pada Korong Kasai 
Nagari Tapakis yang menyebabkan 1.200 KK mengungsi. Ketinggian banjir diperkirakan setinggi 80 cm. 
Oleh sebab itu dalam kajian ini penelitian menggunakan aplikasi HEC-RAS dan GIS untuk menampilkan 
sebaran banjir dan tinggi muka air banjir.Penelitian ini dilakukan dengan menggunakan data primer, 
sekunder dan data DEM yang diunduh dari DEMNAS . Penggunaan aplikasi GIS yaitu Global Mapper 
berfungsi untuk mengubah data DEM yang berformat GeoTiff menjadi prj agar dapat diolah ke dalam 
HEC-RAS. Pada aplikasi HEC-RAS terdapat tools RAS Mapper yang berfungsi menggambarkan hasil 
sebaran banjir dan tinggi banjir. Dari hasil pemanfaatan data DEM menggunakan HEC-RAS dan GIS pada 
Batang Tapakis dapat menampilkan gambaran genangan pada Korong Tapakis dan tinggi banjir antara 70-
80 cm yang sesuai dengan banjir yang terjadi pada tanggal 24 Januari 2023 setinggi 80 cm.  
 
Key words: flood, river, DEM, GIS, HEC-RAS 
 
PENDAHULUAN 

Sungai adalah tempat dan wadah serta 
jaringan pengaliran air mulai dari mata air 
sampai muara dengan dibatasi oleh garis 
sempadan (Peraturan Pemerintah Nomor 38 
Tahun 2011). Sungai mengalir dari hulu dalam 

kondisi kemiringan lahan yang curam berturut-
turut menjadi agak curam, agak landai dan 
relatif rata. Arus relatif cepat di daerah hulu dan 
bergerak menjadi lebih lambat dan makin 
lambat pada daerah hilir. Sungai merupakan 
tempat berkumpulnya air di lingkungan 
sekitarnya yang mengalir menuju tempat yang 
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lebih rendah. Daerah sekitar sungai yang 
mensuplai air ke sungai dikenal dengan daerah 
tangkapan air atau daerah penyangga. Sungai 
sebagai sumber air merupakan salah satu 
sumberdaya alam yang mempunyai fungsi 
serba guna bagi kehidupan dan penghidupan 
manusia. 

Kabupaten Padang Pariaman dilalu oleh 
beberapa sungai besar salah satunya sungai 
Batang Tapakis. Pada Rabu, 24 Januari 2023 
terjadi banjir di Korong Kasai Nagari Tapakis 
yang menyebabkan 1.200 KK mengungsi. 
Ketinggian banjir diperkirakan setinggi 80 cm. 
Oleh sebab itu dalam kajian ini penelitian 
menggunakan aplikasi HEC-RAS dan GIS 
untuk menampilkan sebaran banjir dan tinggi 
muka air banjir. 

Permodelan dengan integrasi HEC-RAS 
dan ArcGIS menghasilkan informasi mengenai 
zonasi daerah genangan banjir yang terdampak 
di 3 kecamatan yaitu, Kecamatan Murhum 
mencapai luas genangan maksimum 0.098 km2 
tersebar di Kelurahan Wajo dan Melai, 
Kecamatan Batupoaro dengan luas genangan 
0.061 Km2 berada di Kelurahan 
Nganganaumala dan Kecamatan Wolio 
tersebar di Kelurahan Bataraguru, Tomba, 
Wale dan Bukit wolio indah dengan luas 
genangan mencapai 0.309 Km2, ketiga 
kecamatan tersebut memiliki kelas resiko 
sangat rentan (Nuzul dkk., 2021; Putra, 2022). 

Persentase kesesuaian antara peta ancaman 
banjir berbasis GIS untuk DAS Deli di Kota 
Medan hasil analisis menggunakan HEC-RAS 
dengan riwayat kejadian DAS Deli di Kota 
Medan hasil validasi terhadap setiap kelurahan 
terduga terdampak dengan menggunakan 16 
titik kontrol adalah 81.25%. angka tersebut, 
menunjukan bahwa hasil analisis dapat 
digunakan untuk mendukung pembuatan peta 
risiko banjir dan menjadi dasar bagi penelitian-
penelitian selanjutnya (Adly, 2021; Amaliani, 
2021) 

Fadlan dkk. (2016) menunjukkan dari hasil 
simulasi pada debit rencana kala ulang 2, 5, 10, 
25, 50, 100, dan 200 tahun didapatkan 

perbedaan luas genangan. Semakin banyak 
(tahun) simulasi yang dilakukan, maka luas 
genangan akan semakin tinggi dikarenakan 
debit air yang semakin meningkat. Daerah yang 
tergenang berada di dua Kecamatan yaitu 
Kecamatan Limbong dan Kecamatan Seko 
(Fadlan dkk., 2016; Immanuella, 2022) 

Penelitian yang dilakukan memiliki 
batasan-batasan yaitu lokasi penelitian berada 
di Batang Tapakis, Kabupaten Padang 
Pariaman. Data potongan melintang didapatkan 
dari data DEM. Data curah hujan menggunakan 
Metode Polygon Thiessen 3 stasiun terdekat 
yaitu Stasiun Santok, Stasiun Kasang dan 
Stasiun Lubuk Napar. Menggunakan aplikasi 
Global Mapper. Menggunakan aplikasi HEC-
RAS. 

Adapun manfaat yang dapat diperoleh dari 
penelitian ini adalah untuk mengetahui hasil 
penggunaan integrasi aplikasi HEC-RAS 
dengan GIS menggunakan data DEM pada 
Batang Tapakis, Kabupaten Padang Pariaman 
sehingga dapat menjadi referensi penelitian 
yang berhubungan dengan penggunaan aplikasi 
HEC-RAS dan GIS. Selain itu permodelan 
menggunakan HEC- RAS dapat menampilkan 
simulasi aliran permanen maupun tidak 
permanen dari profil muka air di saluran 
sungai, sedimentasi, analisis kualitas air dan 
desain hidraulik. 

METODOLOGI PENELITIAN 
Menurut Rahayu dkk. (2009), banjir 

didefenisikan sebagai tergenangnya suatu 
tempat akibat meluapnya air yang melebihi 
kapasitas pembuangan air disuatu wilayah dan 
menimbulkan kerugian fisik, sosial dan 
ekonomi. Sedangkan menurut Kodoatie 
(2005), terjadinya genangan akibat 
pengendalian banjir tidak terkendali pada lahan 
ruang terbuka hijau sehingga menimbulkan 
aliran permukaan. 

Faktor penyebab banjir ada dua, yaitu 
faktor alam dan faktor manusia. Yang termasuk 
faktor alam, di antaranya curah hujan, 
pengaruh fisiografi, erosi dan sedimentasi, 
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kapasitas sungai dan pengaruh air pasang. 
Sedangkan yang termasuk faktor manusia, di 
antaranya perubahan kondisi daerah pengaliran 
sungai, kawasan kumuh dan sampah. 

Pada penelitian ini data curah hujan 
dianalisis menggunakan aplikasi 
hydrognomon. Hydrognomon adalah aplikasi 
yang digunakan untuk melakukan pengolahan 
data hidrologi. Data didapatkan dari lembar 
kerja yang diinputkan. Proses pengolahan data 
yang dapat dilakukan dengan aplikasi ini antara 
lain tahapan kerja, regulasi, waktu pengerjan, 
interpolasi, analisis regeresi, konsistensi data, 
filterisasi data, visualisasi data dalam bentuk 
grafik dan tabel dari deret waktu dan banyak 
lagi (Saputri, 2022). 

Geographic Information System atau 
Sistem Informasi Geografis merupakan sistem 
berbasis computer yang digunakan untuk 
menyimpan dan memanipulasi informasi 
geografis. GIS memiliki empat kemampuan 
menangani data bereferensi geografis 
diantaranya masukan, manajemen data, analisis 
dan manipulasi data serta keluaran (Aronoff, 
1989). GIS dibedakan atas sumber data yaitu 
Data spasial merupakan data yang bereferensi 
geografis atau representasi objek di bumi. Data 
ini diperoleh dari berbagai sumber dan 
berbagai format. Data spasial mencakup grafik 
peta analog, foto udara, citra satelit, survei 
lapangan, pengukuran theodolite, pengukuran 
GPS. Penyajian data dengan model vektor yang 
manampilkan, menempatkan dan menyimpan 
data menggunakan titik-titik, garis-garis dan 
kurva atau polygon. Sedangkan penyajian data 
dengan model raster yang manampilkan, 
menempatkan dan menyimpan data 
menggunakan struktur matriks atau piksel yang 
membentuk grid. Data atribut, 
mendeskripsikan karakteristik atau fenomena 
pada suatu objek data dalam peta yang tidak 
mempunyai hubungan dengan posisi geografi. 
Data atribut berupa data statistik, data 
pengukuran (Al Amin, 2015; Nomiritae dkk., 
2023). 

HEC-RAS adalah suatu program yang 
digunakan untuk dapat memodelkan aliran di 
sungai yang dibuat oleh Hydrologic 
Engineering Center (HEC) yang mana satu 
divisi dengan Institute of Water Resource 
(IWR) dibawah US Army Corps of Engineers 
(USACE). Penelitian mengenai simulasi 
hidrolika telah banyak dilakukan dengan 
menggunakan software HEC-RAS. Pada 
aplikasi tersebut terdapat tools HEC-RAS 
Mapper yang terdapat pada seri HEC-RAS 6.1 
 
Lokasi Penelitian 

Penelitian ini berlokasi di Batang Tapakis, 
Kabupaten Padang Pariaman seperti terlihat 
pada Gambar 1.  

 
Gambar 1. Lokasi penelitian 

Pengumpulan Data 
Metode pengumpulan data yang dilakukan 

adalah studi pustaka yaitu mencari jurnal 
online dan beberapa buku untuk menjelaskan 
rumus-rumus yang ada pada pembahasan. Alat 
yang digunakan adalah computer atau laptop 
yang telah terpasang aplikasi HEC-RAS 6.4.1 
yang didalamnya terdapat RAS Mapper dan 
data yang dibutuhkan yaitu data curah hujan 10 
tahun terakhir, data DEM Sumatera Barat dan 
Peta Tutupan Lahan Kabupaten Padang untuk 
menganalisa dan mengolah data hidrologi, 
terutama dalam bentuk time series. Untuk 
pengolahan data dapat diimport dengan format 
data (*.txt) maupun secara manual. Kemudian 
dilanjutkan dengan uji probabilitas. 
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Analisis debit rencana menggunakan metode 
rasional yang membutuhkan  
Pariaman. 
 
Analisis Data 

Analisis data yang dilakukan dalam 
penelitian ini adalah analisis curah hujan 
dengan periode 10 tahun menggunakan stasiun 
terdekat. Data diperoleh dari PSDA 
(Pengelolaan Sumber Daya Air) Provinsi 
Sumatera Barat, data tersebut dibutuhkan untuk 
menyusun suatu rancangan pengendalian 
banjir, analisis debit banjir periode ulang 
menggunakan metode rasional, aplikasi GIS 
yang dipakai yaitu Global Mapper untuk 
menjadikan data DEM format GeoTiff menjadi 
pjr agar bisa diolah pada aplikasi HEC-RAS, 
pemodelan pada penelitian ini menggunakan 
HEC-RAS 6.4.1 yang didalamnya terdapat tools 
RAS Mapper, memberi upaya penanggulangan 
banjir di Batang Tapakis, Kabupaten Padang 
Pariaman. 

HASIL DAN PEMBAHASAN 
Analisis Curah Hujan 

Analisis data curah hujan rata-rata 
kawasan bertujuan untuk menghitung debit 
rancangan banjir di daerah tersebut. Dalam 
menganalisis data curah hujan digunakan 
Metode Polygon Thiessen. Pada metode ini 
memerlukan beberapa stasiun curah hujan 
terdekat yang akan mempengaruhi daerah 
tangkapan (Catchment Area). Pemodelan 
metode ini dan presentase luas yang 
mempengaruhi diperoleh dari digitasi aplikasi 
ArcGIS. Berikut gambar yang menunjukkan 
DAS Tapakis, stasiun curah hujan serta 
presentase luas yang mempengaruhi. Terdapat 
3 stasiun yang mempengaruhi yaitu Stasiun 
Santok, Stasiun Kasang dan Stasiun Lubuk 
Napar. 
Analisis distribusi frekuensi 

Analisis dapat dilakukan secara manual 
dengan rumus-rumus yang sudah ditetapkan, 
namun untuk mempermudah pekerjaan 
menganalisis distribusi frekuensi curah hujan 
dengan menggunakan aplikasi Hydrognomon. 

Berikut tampilan analisis curah hujan periode 5 
tahun Hydrognomon dari berbagai metode. 

 
Gambar 2. Tampilan Analisis Hydrognomon 

 
Berikut hasil analisis menggunakan 

aplikasi Hydrognomon dengan metode normal, 
log normal, log pearson III dan gumbel dengan 
periode ulang 2, 5, 10, 25, 50 dan 100 tahun. 
 

Tabel 1. Nilai Curah Hujan Rancangan 

No Tahun 

Hujan Rancangan (mm/hari) 

Normal Log 
Normal 

Log 
Pearson 

III 
Gumbel  

1 2 151.71 112.54 104.98 129.17 
2 5 267.15 215.68 191.68 250.43 
3 10 327.48 303.02 286.60 330.71 
4 25 391.83 435.46 472.38 432.15 
5 50 433.40 550.40 679.10 507.40 
6 100 470.78 679.48 967.67 582.10 

 
Pengujian distribusi menggukanak Metode 

Chikuadrat dan Smirnov Kolmogorov didapati 
sebagai berikut. 
 

Tabel 2. Hasil Uji Chikuadrat dan Smirnov 
Kolmogorov 

Distribusi 
Probabilitas 

Chikuadrat 
Smirnov 

Kolmogorof Keterangan X 
hitung 

X 
kritis 

ΔP 
hitung 

ΔP 
kritis 

Normal 13.00 5.991 0.25 0.41 Tidak 
Diterima 

Log 
Normal 5.00 5.991 0.11 0.41 Diterima 

Gumbel 7.00 5.991 0.22 0.41 Tidak 
Diterima 

Log 
Pearson 
Type III 

1.00 5.991 0.61 0.41 Tidak 
Diterima 
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Analisis Debit Banjir Periode Ulang 

Koefisien Limpasan  
Koefisien limpasan mempengaruhi analisa 

debit banjir rencana. Nilai koefisien 
bergantung pada tutupan lahan yang dialiri oleh 
air. Perhitungan nilai C diperoleh total dari 
koefisien C tiap lahan berdasarkan Tabel dikali 
dengan luas masing-masing lahan dibagi 
dengan total luas semua lahan di DAS tersebut. 
Pada penelitian ini digunakan peta tutupan 
lahan yan didapat dari BPDAS-HL Agam 
Kuantan dan diolah menggunakan aplikasi 
ArcGIS dapat dilihat pada Gambar 2 dan 
berikut hasil perhitungan untuk nilai C pada 
DAS Tapakis pada Tabel 3. 
 

Tabel 3. Perhitungan Koefisien Limpasan 

No 
Deskripsi 

Lahan Luas C 
C x 
A 

C 
rata 

1 Hutan Lahan 
Kering 
Sekunder 

6.20 0.02 0.12 

0.30 

2 Pertanian 
Lahan Kering  

13.70 0.4 5.48 

3 Pertanian 
Lahan Kering 
Campur 

36.52 0.4 14.61 

4 Tanah Terbuka 0.04 0.2 0.01 
5 Sawah 27.03 0.15 4.05 
6 Pemukiman 1.71 0.7 1.20 

Total 85.20 
 

25.47 

Waktu Konsentrasi 
Perhitungan waktu konsentrasi 

menggunakan Metode Kirpich memerlukan 
data panjang sungai dan kemiringan sunngai. 
Berdasarkan hasil perhitungan dengan 
menggunakan aplikasi ArcGIS, panjang sungai 
Batang Tapakis sepanjang 30.98 km dan 
elevasi hulu setinggi 0.069 km dan elevasi hilir 
setinggi 0.004 kemiringan sungai 
menggunakan rumus sebagai berikut: 

𝑆𝑆 = 𝐻𝐻
0,9 x 𝐿𝐿

  (1) 

𝑆𝑆 =
(0.069 − 0.004)

0,9 x 30.89
= 0.002 

Dengan demikian, untuk waktu konsentrasi 
sebagai berikut: 

𝑇𝑇𝑇𝑇 = �0.87 x 30.982

1000 x 0.002
�
0.385

  (2) 

     = 9.59 jam 

     = 575.36 menit 

Dari hasil Tc diperoleh termasuk kategori 
besar dikarenakan sungau Batang Tapakis 
termasuk sungai yang panjang, sehingga 
membutuhkan waktu lama untuk mengalirkan 
air dari hulu ke hilir. Nilai Tc digunakan untuk 
menghitung intensitas curah hujan. 

Metode Haspers 
Untuk menghitung debit rencana digunakan 
Metode Haspers karena luas DAS Tapakis 
85,20 Km2. 
Luas catchment area (A) : 85.20 km2     
Panjang sungai (L)  : 23.11 km    
Kemiringan sungai (S) : 0.009 
 
Langkah Perhitungan:  
 
a. Koefisien aliran (𝛼𝛼) 

𝛼𝛼 = 1+0.012∙𝐴𝐴0.7

1+0.075𝐴𝐴0.7  (3) 

𝛼𝛼 =
1 + 0.012 ∙ 85.20.060.7

1 + 0.075 ∙ 85.20.060.7 = 0.473 

 
b. Waktu kosentrasi (tc) 

𝑡𝑡𝑐𝑐 = 0.1 ∙ 𝐿𝐿0.8 ∙ 𝑆𝑆−0.3  (4) 

𝑡𝑡𝑐𝑐 = 0.1 ∙ 22.96.910.8 ∙ 0.009−0.3

= 5.041 𝑗𝑗𝑗𝑗𝑗𝑗 
 

c. Koefisien reduksi (𝛽𝛽) 
1
𝛽𝛽

= �1 + 𝑡𝑡𝑟𝑟+�3.7∙10−0.4𝑡𝑡𝑟𝑟�
𝑡𝑡𝑡𝑡2+15

� ∙ 𝐴𝐴
3
4�

12
  (5) 

1
𝛽𝛽

= �1 +
5.041 + (3.7 ∙ 10−0.4∙5.041)

5.0412 + 15
�

∙
85.203 4�

12
 

𝛽𝛽 = 0.773 
 

d. Menghitung hujan harian yang turun (Rt) 
𝑟𝑟 = 𝑡𝑡𝑡𝑡∙𝑅𝑅24

𝑡𝑡𝑡𝑡+1
 (6) 
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𝑟𝑟 =
5.041 ∙ 112.540

5.041 + 1
= 93.910 𝑚𝑚𝑚𝑚 

e. Menghitung hujan harian maksimum (q) 
𝑞𝑞 = 𝑟𝑟

3.6∙𝑡𝑡𝑡𝑡
 (7) 

𝑞𝑞 =
93.910

3.6 ∙ 5.041
= 5.175 𝑚𝑚3 𝑑𝑑𝑑𝑑⁄ 𝑘𝑘𝑘𝑘2⁄  

 
f. Menghitung debit (Q) 

𝑄𝑄 = 𝛼𝛼 ∙ 𝛽𝛽 ∙ 𝑞𝑞 ∙ 𝐴𝐴  (8) 

𝑄𝑄 = 0.473 ∙ 0.773 ∙ 5.175 ∙ 85.20
= 61.22 𝑚𝑚3 𝑑𝑑𝑑𝑑⁄  

 
Tabel 4. Perhitungan Metode Hapers 

T R24 QT 
2 112.540 61.22 
5 215.679 117.32 
10 303.024 164.84 
25 435.460 236.88 
50 550.396 299.40 

100 679.480 369.62 
 
Berdasarkan hasil perhitungan didapat 

bahwa debit pada Batang Tapakis memiliki 
debit yang cukup besar. 

Pemodelan GIS 
Pemodelan ini bertujuan membuat data 

geometri Batang Tapakis. Pada pemodelan ini 
membutuhkan data DEM dari website 
DEMNAS yaitu 
https://tanahair.indonesia.go.id/demnas/#/,.  

Pemodelan GIS pada penelitian ini 
menggunakan aplikasi Global Mapper. Data 
DEM yang berformat GeoTiff diubah menjadi 
pjr agar dapat diolah ke aplikasi HEC-RAS. 
Berikut langkah-langkah pemodelan GIS: 
a. Download data DEM pada website 

DEMNAS. 
b. Buka aplikasi Global Mapper. 
c. Masukkan data DEM yang telah di 

download. 
d. Klik Tools > Configure > Projection (ubah 

menjadi UTM) > Ok. 
e. Klik data DEM > Layer > Export – Export 

Layer (s) to New File > GeoTiff > Ok > 

Centang Generate PRJ File > pilih lokasi 
penyimpanan file. 

Pemodelan HEC-RAS 
Pemodelan aplikasi HEC-RAS 

menggunakan seri 6.4.1 yang di dalamnya 
terdapat tools RAS Mapper. Pemodelan ini 
bertujuan untuk mengetahui sebaran banjir dan 
ketinggian banjir yang terjadi pada Batang 
Tapakis, Kabupaten Padang Pariaman. Berikut 
langkah dari pemodelannya: 
a. Buka aplikasi HEC-RAS 6.4.1 > File > New 

Project > pilih lokasi penyimpanan file. 
b. Klik tools RAS Mapper. 
c. RAS Mapper > Tools > Set Projection For 

Project. 
d. Input data dari Global Mapper yang telah 

berformat pjr > unit (meter) > Ok. 
e. Mendigitasi data geometri pada layer rivers, 

cross section dan storage areas. 
 

 
Gambar 3. Digitasi Data Geometri 

 
Gambar 4. Running 

https://tanahair.indonesia.go.id/demnas/%23/
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Gambar 5. Hasil Pemetaan Menggunakan RAS 

Mapper 

Validasi Lapangan 
Validasi lapangan bertujuan memastikan 

kecocokan sebuah aplikasi dalam pengolahan 
data sesuai dengan yang terjadi di lapangan 
sehingga mampu memberikan hasil yang tepat 
sehingga dapat dipercaya. Dari hasil aplikasi 
RAS Mapper dengan hasil wawancara dengan 
masyarakat sekitar didapatkan bahwa hasil dari 
aplikasi memiliki kemiripan dengan data 
lapangan. Berikut kedalaman banjir dari hasil 
aplikasi RAS Mapper pada Gambar 6 dan 
Gambar 7. 

 
Gambar 6. Kedalaman Genangan Banjir pada 

Patok 1 

 
Gambar 7. Kedalaman Genangan Banjir pada 

Patok 2 

 
Perhitungan kedalaman banjir menggunakan 
rumus sebagai berikut :  
a. Pada patok 1 

H  = MAB- elevasi dasar rumah warga 
     = 4.9 – 4.2  
     = 0.7 m ≈ 70 cm 

b. Pada patok 2 
H  = MAB- elevasi dasar rumah warga 
     = 5 – 4.2  
     = 0.8 m ≈ 80 cm 

Patok 1 dan 2 berlokasi pada titik tinjauan 
yaitu Korong Kasai Nagari Tapakis. 
Kedalaman banjir yang terjadi pada tanggal 24 
Januari 2023 setinggi 80 cm mendekati 
dengan hasil ketinggian banjir pada patok 1 
yaitu 70 cm dan patok 2 setinggi 80 cm. 
 
KESIMPULAN 

Setelah dilakukan penelitian, maka dapat 
diambil kesimpulan bahwa pemanfaatan data 
DEM menggunakan HEC-RAS dan GIS pada 
Batang Tapakis dapat menampilkan gambaran 
genangan pada Korong Tapakis dan tinggi 
banjir antara 70-80 cm yang sesuai dengan 
banjir yang terjadi pada tanggal 24 Januari 
2023 setinggi 80 cm. 
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